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ABSTRACT

In this thesis, we propose the synthesis of piezoresistive pressure transducer which has
polysilicon diaphram structure. Regarding the experiment, we focus on three kinds of synthesis
parameters, area and thickness of diaphram as well as applied pressure. Varying these synthesis
parameters as, 100 x 100, 200 x 200, 300 x 300 and 400 x 400 pmz for area, 0.5, 0.8, 1, 1.5 and 2 pm
for thickness and 2-20 mPa for applied pressure, we would like to study the effects of these
parameters on sensitivity and frequency respond of  synthesized transducer by utilizing
ConventerWare  to analyze. According to the experiment results, we conclude that this proposed
pressure transducer with appropriate synthesis conditions, 620 x 620 me size/ 0.5 pm thickness and

895 x 895 um ? size/ 1 pm thickness, can be implemented as a small microphone.
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a9
wa wan 1931 unalaey

AN el Fyanewu | Famew |  iilew INY3 orilua
Density, Pm (kg/m’) 2320 2330 5350 3510 5316
Melting point, Tmp (°C) - 1410 937 3827 1238
Boiling point, T, °0) - 2355 2830 4827 N/A
Electrical conductivity,
o (10" S/cm) - 4x10” | 3x10° ~10" ~10°
Energy band gap, = (eV) 1.1 1.1 0.67 5.4 1.35
Thermal conductivity, K (W/m/K) 34 168 60 1000-2600 370
Specific heat capacity, ¢, (J/K/kg) 678 678 310 523 -
Temperature
expansivity, O, (10-6/K) 2-2.8 2.6 5.7 1 5.7
Dielectric constant, € - - 11.7 16.3 5.1 12
Yong's modulus, Em (GPa) 161 190 - 542 -
Breakdown field (MV/cm) - 0.3 0.1 - 0.5

2.1.3 nszvaumsadrailanlnadaneu (3-4]

TumsadrailduInddanousy191n309 LPCVD (Low Pressure Chemical Vapor
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AN (quartz tube) NTINTLUBNI IULUIUOUFIYNADNTOUAIWTNIABS 3 Tou Tnsaadrsves
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dnsvauu I anatulunenielaglulasindn WeRvisannaunisn 2.3 92
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E=poJ+7,pyJ 0, (2.3)
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coefficient)
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A
P e, (2.8)
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Tudueudedudiotmuald 7 Ao duilseansitloTaSFanUauva1e (transverse
)
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piezoresistive coefficient) AIUUIINTUNITN 2.3 D3 2.8 w1dn
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Ap 1
GF, - (2.20)
Po &

A A = . 4 ° v o | -
o g, A9 ANUIATUA (strain) “]N?”i”ﬁﬂﬂ‘]ujmvlﬂ‘iﬂﬂﬂﬂs'lﬂ’Ju‘UﬂQﬂ'nllU']Tﬂ
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£ = AT] (2.21)
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V =V x E (2.23)
R
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2.4 anhlumsnauaua [6]
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= o a A = &
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o
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2.5.1.1 anuhlumsnevanes (Sensitivity)
quandandinyigaveslulas vy de anullunsSudyara naulives
13 Tas Tluszuaaaniaoilu dBV/ubar 3o dBV fie mszaunsIauIoonily dB Meufy 1V #

@
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(Frequency Response) a1 uaz luTas Tluvunaidng vziinauldudanuinevauoags

2.5.1.2 mmauaumﬁnmm’c’; (Frequency Response)
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Omnidirectonal Pattern Bidirectonal Pattern Resultant Pattern
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6.0x10" —s8— 4 mPa
- —e— B8mPa
4.0x10° '/“‘"\ 4 12 mPa
4 N\ —v— 16 mPa
7 2010° ] e :\\ + 20 mPa
3 | e—a 3\
a2 0.0 _ \\L_K‘
g
: ==
R ) T
? 200 - e = S
] »> \\'\' -—a i
*
-4.0x10* | . Yv—v
| g
-6.0x10° ! y T Az T T T T T T T
0.0 10.0 20.0 30.0 40.0 50.0
POSITION (um)

THICKNESS 0.8 um

(1) ATINANUFURNUTIEN IR NUAUS VAN UITAAUN YT 0.8 um

310 5.2 duvianaddumunuudininuu laezusuvnng 100 X 100 pm’ finnumunae



STRESS (MPa)

STRESS (MPa)

4.0x10"

] —a— 4 mPa
3.0x10° —eo— B8 mPa
o ] —a— 12 mPa

’ —v— 16 mPa
1.0x10° - ¢ 20mPa
0.0 _

. e e B P

-1.0x10™ —  *—e—— oo
4 ] .\' _\.x“___"*"'—'—*
-2.0x10° -

] .f““v___.'_,
-3.0x10° | T——
-4.0x10° ! T ™ T T T T T T T

0.0 10.0 20.0 30.0 40.0 50.0

POSITION (um)
THICKNESS 1 um

(M) NTINANUFURUTIZHIIAMAUA VAWM UINAUHYT 1 um

1.5x10" - —=— 4 mPa
; i —e— 8 mPa
1.0x10°* 7N\ -4— 12 mPa
| /AN
;/ = "~. S R 16 mpa
soxt0' 7 4 '-\ + 20mPa
L 2 E
0.0 o )
] .E\H‘::-h"‘———.
d \\§~..:th~.. —s— a__ g -
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e ’ .
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POSITION (um)

THICKNESS 1.5 um

() NTNANUFURUTIEH IR NUAUN IR WHUIAAWHY 1.5 um
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8.ox10"
6.0x10° : * —a— 4 mPa
) ] —e— 8mPa
4.0x10" —a— 12 mPa
2 0x90" - —v— 16 mPa
= - 1 *— 20 mPa
q 200 S
g -2
g 4 -H".——__‘ ° °
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1] _‘—“—_-“
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E i e
-8.0x10" ~—
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T ¥ T
0.0 10.0 20.0 30.0 40.0 50.0

POSITION (um)
THICKNESS 2 um

() PNANUFUNUTTEH I NUAUAUAMHUINAIINHY 2 um

i 5.2 (f0)

5.1.2 Inaganeulaezurlsnving 200 X 200 pm’
HAMIMIFNAUHUIMIIIAUMUUL InGFaneu Taozinsuuua 200 X 200 pm’ #i
- o A oA
AWHUI 0.5 0.8, 1, 1.5 uaz 2 um laviinnuauinnldounlas 5 a1 Ao 4. 8. 12, 16 11ag 20 mPa
=§ = o aa @ o
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- 1 & [ o v : a A o o o '

Raveyghn 75 - 125 um FIMslszanurisdiuniaiuvzaanlszuim 90 tlofiFuasinainiy

Wugaga dumissudulumsmmvasdumiaimsneidumunudminiensgii 100 um



STRESS (MPa)

STRESS (MPa)
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T T T ¥ T v T T T
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THICKNESS 0.5 um

(M AFIIMANNFURUTIZHINANAUAUF I HUINAUHYY 0.5 um
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A -1 L
roxig ] —°— 8mPa R ‘.r
010 [
.1 —% 12 mPa » .
1.8x10 - @
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1.6%10" :
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1.4x%10™° «
ry v X
L oy |asttssa,, V
1.2%10" - y A T
. ] o ¥V A & Y, ]
1.0010™ d} ‘A “ LY
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. ] p fv" P o .. \
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4.0x10" - ,fv;.. .#..III.II--.. o‘lv‘.
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*
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THICKNESS 0.8 pm

() NINANUAUNUTTEHINAN AU URIHLIAA UMY 0.8 um
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STRESS (MPa)

STRESS (MPa)

w10’/ —"— 4 mPa
—e— B mPa o** "%,
£
1.ox10* { —&— 12mPa %’ .
|—»— 16 mPa o caddd = \
o | v v | o
soxt0'{ ¢ 20mPa 4 [V abta, Yy @
A A v
| o Y A L
R ™ Y
6.0x10" - R L T
) v A 0*%%0 o
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L J 3
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THICKNESS 1.5 pm

gﬂﬁ 53 (79)
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STRESS (MPa)

1.5x10°
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POSITION (um)
THICKNESS 2 pm

;ﬂf‘i 5.3 (AD)

5.1.2.2 AMHHIANHMZN TN INIUMUUIDUHININ
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2.0x10™ \' . 12mPa
i) P \0 —v— 16 mPa
1.5x10"* a
w ] Yo —*  20mPa
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STRESS (MPa)

STRESS (MPa)

4
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1 “::-0 : / L] —— 8 mPa
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POSITION (um)
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—_— ) —e— BmPa
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= ::--..__.__.
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POSITION (um)
THICKNESS 1.5 pm

(1) PINANUFURUTIEHINANWAUAURWHUIAAIUWY 1.5 um

5U% 5.4 (n0)
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4.0x10" - » —n— 4 mPa
i | : —e— 8 mPa
3.0x10° -
| —a— 12 mPa
2.0x10" - —wv— 16 mPa
- N ~e - 20 mPa
& 1.0x10" -
v 0.0 |
7] . L8
& | “z-..:::‘-I-hl-—l-—-——.--l—l—-—l
- 4 ] & hb.“"-_
o -1.0x10 | \\::-:-1.1 *-®-0-e-0-0o-0
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POSITION (um)

THICKNESS 2 um

() NIMANUAUNUTIZH A NUAUTUM IR UINATILHYT 2 um

11l 5.4 (A0)

5.1.3 Inasaneulaezusuuina 300 X 300 pm’

2

HaMIM A MiImINaId ML Inaganou laezums uauna 300 X 300 um’ 7
ANWHUI 0.5 0.8, 1, 1.5 102 2 um Tasdinnuduinldounilas s i fie 4, 8,12, 16 Ua% 20 mPa
FevziidnwarmanemdumnnnIndsanoy 2 Snuwy do MITNAIUMULU VYUY 1A
MIIIFIRILNIUIITR RN
5.1.3.1 AMHUIAIHUZMINIANIHMUIBUYIY

wamswninﬁmmiaﬁﬁ'numzmnnﬁnﬁmmuuuiwﬁéﬁﬁﬂﬂu'lﬂﬂzuﬂimnlmmu
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]
a A

e ] & ' o ' c:‘ < d o "
iRauogn 130 - 170 um “Udﬂ1'iﬂ‘i$u1ﬂl‘lf’ldﬂ'lllﬁuduu‘ﬂ:ﬂﬂ'ﬂﬂixlﬂm 90 !ﬂﬂ‘il“]ﬁ.lﬂil'lﬂﬂ'lﬂ'ﬂi.l

Wugega dumiusudulumsmmssdumiimsnaddumumundamn fe ogit 150 um



STRESS (MPa)

STRESS (MPa)

Ui 5.5 Aumdanaddumumuvinuuulaozudsuvua 300 X 300 gm
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—s— 4 mPa
—a— 12 mPa
8.0x10° —v— 16 mPa
+ - 20 mPa
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2.0x10™
0.0 _
I L T T T L I ¥ T L I ¥ T
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() NI MANUFURUTTEH AN AUFUA W LINAUNYT 0.8 um

5
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STRESS (MPa)

STRESS (MPa)
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POSITION (um)

THICKNESS 1.5 pm

(1) nIMANIANRU T T INANALAUMUMLEAAALEMY 1.5 um

31]"1’% 5.5(AD)
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6.0x10
—a— 4 mPa
— —e— 8 mPa
—a— 12 mPa
. | —v— 16 mPa
4.0x10" -
* 20 mPa
? -
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3 J
w
E 2.0x10° -
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T T
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q1lii 5.5 (0)

5.1.3.2 dumiainasmInndmmUDFen
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a0 lassINVDING 5 ANUHU



1.5x10" ° —ea— 4 mPa
‘ —e— 8 mPa
1.0x10™" - —a&— 12 mPa
| —wv— 16 mPa
=  50x10" - 5 —e— 20 mPa
¢ ; <2 ‘}
a 0.0 _
o ; {! —.‘.'.'""'l Ssssssaw
— "0.. g
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POSITION (um)
THICKNESS 0.5 um
(M) NIMANNFUNUT 2N NIAUAUAIUNUINAUNU 0.5 um
8.0x10 "
7.0x10" ” —" 4mPa
6'0::10" ; ‘ —e— 8mPa
s —4— 12mPa
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E oo o
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THICKNESS 0.8 pm

(V) PIINANUARUTIZHINANIAUAIR WML INAIUHLT 0.8 um

3N 5.6 Aumianaddumusuudminuu laozuds uia 300 X 300 um’ NANUHUIAE
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STRESS (MPa)

5.0x10 " —a— 4 mPa
4.5x10"
4.0x10" =t— 8 mPs
3.5%10" —a— 12 mPa

)
e Bt —v— 16 mPa
2.5x10

: = =
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THICKNESS 1 um

(M naMANUFURU TSI NUAUAUA HLINAIUHYY | um
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—e— 8 mPa
—a— 12 mPa
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POSITION (um)
THICKNESS 1.5 um

T
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11 5.6 (A0
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1.2x10"

1.0x10™ — —a— 4 mPa

g —e— 8mPa

. —a&— 12 mPa
.0x10 "

- —v— 16 mPa
w  A40x10” . av, —+- 20 mPa
g 2.0x10™ - o
e 0.0 _ =
E ) ! i '."'I-'..-l----‘-a--
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POSITION (um)

THICKNESS 2 um

() nsMANUFURUTIEH I NUAUAUMUMUINA NI 2 um

;ﬂi"i 5.6 (AD)

5.1.4 Inadanovlaezursuvina 400 X 400 um’

HANMTMIIIAIMINTNMIAuMuuu Indganeu laozisuviuna 400 X 400 um’ #

ANUNUT0.5,0.8, 1, 1.5 1a 2 um Tastanuauin/dounilas 5 a1 An 4. 8. 12, 16 naz 20 mPa

A -~ % ey w LY
FIVZUANHAUEMINIAUMUDU INATARDY 2 NN AD N1SIFIRIUMULVV VLY LA

A5 19A N UN UL VAR N
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STRESS (MPa)

POSITION (um)
THICKNESS 0.5 um

(M) ATIMANUTURUTTEH I NAL AR MU IRA LN 0.5 um

, |—®"— 4 mPa
tex10'1 | o pa
1—4— 12 mPa
8.0x10° | _y__ 16 mPa s
.
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w
lé-; 4.0x10*
w e
2.0x10™ -
0.0 |
T N T T I A T
0.0 100.0 200.0 300.0 400.0

POSITION (um)
THICKNESS 0.8 um

() AINANUFURUTTEH IR NIAU AR WML RiA LYY 0.8 um

AN 5.7 dumianaddumunvinuouTaezurs e 400 X 400 um’ NANMUULIAGA



STRESS (MPa)

STRESS (MPa)
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2.0x10™

1.6x10™

1.2x10™
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4. nani lonou .Imarr%HqT‘lJimﬂ“lﬂn*nwuwmme New Project

5. ld¥e Diaphragm Design 11904 Please Enter A Project Name ﬁa;ﬂ‘ﬁ f-2

@ Please Enter A Project Name
IDiaphrangesign

Ok Cancel

gﬂﬁ -2 New Project

6. Aaniitfy zifumsadralilsdaiBoudosdagi n-3

Projects rjtl 5"[_?5_] = Setti.ng.;'é:_ x][;%

Last Modified

Last Modified

an... 061212548 19:

[ Files of type |ProjectSemngs Files (*.mps) LI Cancel |

g‘l]ﬁ -3 Project Browser
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7. aanitfu I 1ddazUn n-4
3 ' ' '
a g 1 & 1 =1 =1
Project Browser Uu1/52n0UA0e03dIUAD Project 1Wuauiuanssovnsllsiianse
-~ =] {0 . z 1 a g a
Tdmesinudoyalysidn fieglu Work Directory uaz Setting ifudiuiiuans ldvealysiiad
Yy oy ¥ . & 4 o w o
winanaiilu .mps nedudvveaniiidg 1as Project Browser uamiznfiaztiud1 lsisann
v " a { . i
T1sunsu CoventorWare Junould Tasaan#leneu Inprove Project £ ! uazaiuisoauldsida

vso ladeq 1ddomaden Ildndesmsauudananii lonou Delet X.!

O CoventorWare -0:\Design_FllesDiophragnDesignDiaphisgnbesignmps ) G|

iEira Tools Help
'% Matenals [D10esipn_Files\SharedMPD\mpd1 mpd ~] ﬁl ”I
i
| Process  fcreate anew process =] ﬁl :‘!:! J
? Architect | Designer] Anatyzer |

Gchematic  jcreate a new schernalic -] m",l 4};
:
i

gﬂﬁ -4 Function Manager

CoventorWare " Function Manager si'fluﬁﬁwhﬂﬂmﬂsuﬁﬁﬁfgsﬁawmﬂxﬁ’m'lﬁﬁ'
v A o ! ﬁ ! 14y 9 ! . ﬂ ' Ao
Hmmauiumimammm ) umu‘lﬁmucmmuumzﬂsznam’m%m Material iIUAIUNNTIHUA
e w 1 ;j ' - o 9 & 9 ' =
AMTNUAUDIING LASHDI Process | ‘Hfl".]Ll‘]"lﬂ'I‘HuﬂﬂiBU'Juﬂ'iiﬁi'I\‘lh.llﬂﬂ“lﬂ‘i]gvlﬂﬂﬁ']'ﬁlﬂﬁiu

o Y

Y 1 = é ) ar J
')‘l.lt')ﬂﬂvl‘lj HAZATUANIZUUDD 3 UDUBITWALIDUAAIY
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l. Architect  : Wuduiaanuldld
2. Designer Wudwildlumseenuuunazadra lumamuinme 141y
MIANTIEHHIoTa0amsinuvesluea
1 P 3 = a1 [ ]
3. Analyzer WudmiussyTugaldlumsTinsisyioe dugu

d L%

3.1 MemMech o l¥lumsimsiziauauiingna

3.2 MemElectrotWo l#lumsinsieinmautiania i

3.3 CoSolveEm tWol¥lumsinsizv

o1 v . .
MINIMGIUVoYanManLA Tag(Material Properties Database Setup)
. . Y a g 3/ wa o 1 ~Aq ¥
Material Properties Database 1Hugiudoyafifiudoyavesguaniaiagaenildluns
4 - .
auTumadadaldlaonsadniilonou B8 admuuvesniiieis Function Manager 013
° wa o 3 3 o q’z’ {0 @ [
fmuaguandaiagiududuasunsnnazfluiuasundidgyvesnsosnuuundeninadie
g 1 { L 2 A 3
Tsivaudaunwsizirdeyaioglu Material Properties  Database vz 14ifugudoyaves
v
" =t o " a d o a =) L )
nszUIUMsAsINHd MM MuamAafvz e ldnamsTinsizveenuinia 1da 1091
P Y - [ a1 9 o < : q’:
annsanvzadanioun luiaquazguaniian1a9 18 1Wdvoe Material Properties Database 1119
. . 4 o o s
fiuwanaiu .mpd(Material Properties Database) iiiaa$13T1)s18n T sunsuezinisadra Inad
Vv ar ara 3/ 1 . 6‘;’ = U 9
THlaodaTuld 991n111A19¥09 Function Manager Wuvziiunasdoyaiilu
. . & Y ¢ ] o
D:\Design_File\Shared\MPD\mpd1.mpd 992111 183104 1uTnlaines Shared Fuilulvamosnld

¥
FIUAUNT Work Directory
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(o T T e s oo sy L AL et M ey s e e e
73 Edit Materials in D:\Design_Files\SharedWPD\mpd1.mpd o
g
[ New Material __f] Import Material l % Copy Material )( Delete Material

Material I', |
Fab Process Thin_film
[[Etastic Constants Elastic-Iso -] Edit
l|oensitytgrume3) Constant-Scalar | 2.230000¢-015
!Strass(hlPa) Constant-Scalar L] 0.000000e+000
TCE(1/K) Constant-Scalar ﬂ 4.700000e-006
ermalCond{(p¥Wiumk) Constant-Scalar Pl 1.480000e+008
SpecificHeat{pJikgk) Constant-Scalar e 1.000000e+014
ElectricCond(pS/um) ~ [Constant-Scalar 7] 0.0000002+000
Dielectric - |constant-Scalar Bl 0.000000e+000
iscosity(kg/umis) ' [Consiant—Scaiar x 0.000000e+000
PiezoResistiveCoeffs{1/MPa) ICnnslant_Stalar Ll Edit

Close i m

317 -5 Edit Material ¥99 POLYSILICON

"
a oo

1. ndnitlonow $8liedanthens Edit Material A3 n-4

2. ndniilenou 7] iden POLYSILICON AvgUi n-4
3. ATIVADVAININVDINTIAI Edit Material HUMT199 -1 1aseanunse 1y

4. frdnlbinseiuliudlalaeadnifn _ Eat udelddcsneqaely Hdwunves

o

] . 3 a3 U U o ] ¥
WA Edit Material Wuaziiuily 4 1uimindail

O New wateral | : a%'w%ga*Tﬁﬂi‘fuiﬂﬁ‘lugmi’fay_mﬁn
] mport wateral | : iidhdoyaTageinnouen

Ry cormatens | : Annendeyaiagmolugudoyadoiu
X oslete Matral_| : audoyaageensingudoya

5. aanfitfu __Close | itaTaniheng Edit Material
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Property Data Type Sub prop | Aluminum(film) Silicon Unit
Elastic Elastic-Iso E 7.70e+04 1.69e+05 Mpa
Constants Poisson 3.00e-01 3.00e-01
Density Constant-Scalar 2.30e-15 2.50e-15 Kg/um3
Stress Anlso Sx 10 0 Mpa
Sy 10 0 Mpa
Sz 0 0 Mpa
TCE Constant-Scalar 2.31e-05 2.5e-06 'K
Thermal Cond | Constant-Scalar 2.40e+08 1.48e+08 pW/um*K
Specific Heat | Constant-Scalar 9.03c+14 7.12e+14 pl/kg*K

#3903 UIUM5319(Process Editor)

v
Process Editor 1Hu4uaoun13$1a09n5202un15a219 (Process) lumsaielumamuiia

3
(3-D) vosgunsai laviiainsadenszuaumsilegdaeiu 2 nszurunisio msilgnduildu

(Deposit) az M3naA (Etch) tiosassnmsadafinounes 1ddunszurumsadiansameg iy

Y . o A A A Hq ¥ 9 1
VDIN UM Process Editor umzmmmmmmﬂﬂumiﬁﬂani:mumsmnmu

|
v

BEp

o

%

=Y Cd ' Py s =1
W15 1IADFVDI Process Editor aaunanunsodsuud 1atiaaii

Move Row Up
Move Row Down
Add Deposit Step

Add Etch Step

Add Sacrificial Etch

Enabling/Disabling

Delete Row

0 1 J A
10U Step Mdon 13%u l1lnils Step
2 oA v P
1nou Step Miden 13aaumils Step

) > P
a319nszuIumsgnyuau
#5195 VIUNIAA
#519N3LVIUMIAANVY Sacrificial
lamse hilduoriidon

- A

auufINmen

Ed
@

v
L. anunuveddag (lusgniamsignduilan)

¥
= as o
2. ¥HUAYeIN31Uqnauau (stacked, conformal, planer)

3. wnaveuyuing (uviennumavenmildlunszuaumsia)
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4. A mask perimeter offset

@ o A = ' -; P " A M A [
5. ﬁﬂ‘klmzﬂ"lﬁllﬂﬂ'l‘ﬂﬂiu'liﬂ (uuumﬂmaa‘um15mnwi'fluwummwmamngﬂﬂﬂ)

File Edit View Help

b dl 1T T ARSIl

Mask Name.
Layer Sidewall
Step | Action | Type Name | Material Thickne...{ Color Polarity | Depth{ Offset | Angle | Comment
Etch  |Front, Partial [ S Y 8 green (Cavity -] 1.4] 00
_|Deposit|Planar Sacrificial| OXIDE 0.0 & cyan
" 3 |Deposit/Stacked Nitride |SIN yellow
4 |Etch  |Front, By Depthlii i i cyan  [Cavity -l 02| oo 0.0

Sactrifl... OXIDE
Deposit|Stacked Polysilic..|POLYSILICON

4

1.5

31J’?I -6 Process Editor U89015a314 Diaphragm

¥ b ¥
TapiidsnsadasvunouudazduaouMUS A UL

2

1. 11@14 Function Editor ﬂﬁﬂﬁa 10N create a new process

[
= ~

2. ﬂanw“lﬂﬂﬂum Woilan1 6149 Process Editor

3. @37903202UMINA Step 1 lauaanii lenow Etch 1

e

4. a5 1n3zuMsgnduilud Step 2 Tavaanii lonou Deposit a

¥ "
5. ad1anszumMsgnIuilug step 3 Taondnii loneu Deposit I
6. a513n52UMM3AA Step 4 Tavnaniilonou Eich ]
o . a S N
7. @519N3TVIUMINALLY Sacrificial Step 5 Toaans lonow Sacrificial Etch —|
¥ [
8. #31anszuaumstgniuilud sep 6 Tavnaniiloney Deposic 1|
9. AIMA1ee Aagi 6n
CU ] A:i 9 3 a o . u’a’ A 5
10. YUNNNIZUIUMINAI 199U TAvAANT File > Save Aavoiifu Diaphragm.proc

1.1, ﬂﬂ‘r‘iﬁ‘lﬁin Process Editor Tﬂﬂﬂaﬂﬁ File > Exit

v
o

] 1 Aé e
vIngUaziiin1dd substrate ifugusosvesTumaguiiumsganounioly substrate 1u

=

. i o a ar o = ~ = ¥y A o
UBOI Cavity L‘ﬂu‘ﬂﬂﬂﬂlﬂﬂﬂ’lﬂﬂi&"l]')ilﬂ'l'iﬂﬂﬁ"wﬂﬁﬂ Cavity UAIWAN 1.4 um LAIUYY
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E4
Nitride FouvuBntuTaeiives Cavity vinAReIRUTD Cavity 199 Substrate gaod vy

e & . o a2 w ” a a 4
#1994 Diaphragm Fuilums Polysilicon Fuiivz Idsuauiuuduian1s 1dssomaiy

ilaguazunluiadiornd (Layout Viewing and Editing)

ﬂé'amﬂﬁﬁmuﬂﬂmauﬁﬁiﬁa(Materﬁal properties) 1AA319NTLUIUNITA319(Process)
Souseouda revaelufiumsadiuadiondaesiiiep Layou) Taold Layout Editor (i
n3oaiie lumsadia(Create) 1iud WS (mport) g0 1M (View) uazud lu(Edindoyan1eg 14 Tao
aunsoiudh Indlsznn cIF uag st 91 Tusunsudu 14 TaoTsunsuazualas Idyszinm
ganan Iiu IWdRidhdu 1880 T1suns CoventorWare Tavaunsaidla Layout Editor 1910
idonuiiy) Designer ¥0a111A19 Function Manager Tauidon TWdfifumana .cat 39I0d Cat s
fudoyaues 2 layout Had1edunieudluTag Layot Editor foyaveuadidansoriliadhs
mdndmivgunsel  uazldifuunasdoyavesmsadunwauiifdmiuns Meshing uaz
Solving Mvznanluiadeda'ly

a A d . a A T < .
1. pannunil Designer ﬂﬁﬂ‘ﬁvlﬂﬂmzl onlvla Diaphragm.cat

]
=1

2. 1@ layout Editor laga@nii lonou Layout ediugj v 1ddas1li n-8

Y

¥ ] "
3. AIM1F03I119U0I5131ABAGNT Tool > Option > Grid ldf @199 AagUii n-7

isplay Grid multiple f1

raw grid  True  False

" ¥
310 07 Mm3AsmveInIg
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; ﬂarmﬂu' Apply | Lwaﬂnmﬂnﬂuuﬂaa funiaves Layout Editor
. YanrhersTaondniity  Close
Y o 1 b5 I v o v a o '

- @nsningunssiaien 18 Taeld 15us59a Tool > Ruler udandnanig L wusn
S o ] 9/ - v o 3 = "
DI MUIgAaMenvzIaneeiuszoz oy um

a y 3 o { o 3 ]
. AANNIY Refresh screen 82 1an IdussvinfiTanindunoudi 6

. dnTi lonow Layer Browsed & wUsnguihaiedsgli n-g

Lo

Fllﬂ El:m View Cell Ob,er.1 Modlly Tools Genermors Window Hep

ED-@-W- @ SmB <=

].Q.Gm -8 2R-ARRAAQ 63~ | G~F =Dl |+~

“

%

BONLNNOD O &

5 commana, )
) - T e———— n
a Lnyuu!Edllor Tq;minal 2 [__JLI;IJ|
| Fiie {
11010.0 170.0 =i
1190.0 -10.0
javaOx42

cat:filesave -save true
i1

command%

g‘ﬂ‘ﬁ N-8 Layout Editor Y94 Diaphragm



106

3 cat ayerbrowser

File Layer I I Save Restore . 10s

Natme Color Fill W s
GND biue none VIV
Cavity green solid VIV

gﬂﬁ -9 Layer Browser

¥ 3
vngUduuuiuaiuaieg 1 Layer Browser Nuaasdnyuzaiegdane 11l

4 & s
Name - HAAIFOUDIFUNITA (Mask layer)
o
Color - uanLazAIUNU v UAILDS
L4 .

Fill - uaAwazAIuAY JUUVYeuADS( Solid,Dots, Hatched 1T 1A 1)

Yy ¢ do 4 vy A g
vV o o- auguldadwesiuaunsoueunuldno il

¢ L Ve a

S = aunuliadwesiiuawisaden lanse Lichmsumsudlv)

aunsodounasuanuawes I landnfivea V] uazannsalfiawe fiumuisoden
I&nse i Taudniives s | Tavausonlfonddvionlouviinves Fin 1¢

9. (dond File > Close iitotlaniiiang

10. 7in111@13 Layout Editor Suiin 18 Tauidondi File > Save

11. t@en# File > Exit

@314 Solid Model (Building the Solid Model)

nlridlsimauay dieniaaduuiesudadudeyalunisairelunaa i g
@519 Solid Model l#annudivl Designer AANTIM89 Mode\Mesh L@an create new model Wa2
Aan#leney Start Preprocessor dauflunsGunsrususinlumaanidd deldsunsuais
Faufeeudaniinsng Preprocessor azitlalatdn s

1. adnfilenou =] idon Create new model

2. AanTilemew Preprocessor EEJ {Wiea¥a Solid Model

3. artuminane W ldaadn Diaphragm

4. spaunsenallsunsuairelumaiaia wilnsng Preprocessor aztlalaadnTusif
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5. paniilareu Y] 999 Z-Scale i@enidll 5 MeLuTwinuLILNg Z

E3 CoventorWara(TH) Prepracessor - D

;Ie EM View "SoIdModeI Mesh TodsHeh
sH Pd AGEARAR »+QQaQ4LLL ® O B RE -
o o i S |

= *% Geometry
=15 Sokd Model
=
+ = Layer! (Sacrificial)
& & Layer2(Neride)
=]

¥
& (0 Mesh Model
= E Region 1
=) E# Layer((Substrate)
i (3) Pert_B(Substrate)
= E9 Region 2
[=1E=# Layer3(Polysilicon)
- (5 Part_a(Polysiicon)
(= £3 Conductors
£5 Conductor_0(Conductor_0)
£33 Conductor_1(Conductor_1)

k

gﬂ‘ﬁ N-10 Preprocessor Rendering U89 Diaphragm

~ -] 9 7 = 3/ @ wa A ::
1ngU# n-10 92w 1497 Layerl  (Sacrificial)  vzgndouda lulidiosniniuaou

¥ ¥
ASTUIUNITEI1 (Process) 1U Step 5 1935M3NANLY Sacrificial dautiszielUonTuaa

Naming Entities

g =

¥ ' 1
Yuaeudo I lumseenuvudomuaweiidesn1saslylu Mesh Model uazauyd

> ¥

e 9 3 q,: 4 @ w n’/‘ “ c:’ U = ] y
auauiana lfhwmdeuisdede 1diudag mdsyeriuszdesdaneunaziins Mesh ins1z¥od

h.

v ¥ [l [ . ]
QnAniuazgnussy 1311 Solid Model 1o 141un15 Simulation §1d0smsnldvuiendaninnlaon
Foud19zAna Mesh Imidnasuitodlunmsn/aounilasniiieglu solid Model

v v ¥ ¥
1. N Geometry ANNNHU Substrate Aa lAududendu Polysilicon

2. AANYINABN Add to Mesh Model 92 1Ad 9517 n-11



3. AanNYIN LayerQ (Substrate) 1@on Properties 1Wasuie Name Lﬂu Substrate

=™ Geometry
=- @ Solicl Model -
=1 trate
“ = Layeﬂ (SEICI’IfICIal)
l - Laver2(Nrtr|deJ
. B-EL
= &8 Mesh Model
: EJ =P Regl0n1
 B-E& Layer0(Substrate)
] -7 Part_B(Substrate)
BEE Region 2
- &3 Layer3(Polysilicon)
‘ -7} Part_d(Polysilicon)
El 5 Conductors
gc«:tnductor _O({Conductor_0)
------ &% Conductor_1(Conductor_1)

3‘1]‘?1 N-11 Mesh Model

¥ ¥
GG Analysis Option A9l

4. AANYN Layer] (Nitride) tion Properties nJavude Name 1iu Polysilicon

Conductor

Solid

Suppress, except for MemElectro

k4 ¥
fam Analysis Option A9l

3
Qo

Conductor

Solid

5. A9AIA19Y AegUR -12
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T ————————————— — (o T TN —
Part Properties Pal Pro rties L
I0: 4 D: 6
Name:  [Substrate Name:  |Polysiicon
Material: Isnucou v | “l Material: {powssucom | l
[ ANIY SIS OIONS -~ - -esmem bl ( Analysis Options -
!  Conductor ¢ Dielectric | oo Dibloctrie i
|  Soid " Fluid | soid  © Fuid

¥ Suppress, except for MemElectro

:l [ Suppress, except for MemElectro
[
|
|
|

{‘Gm. T RIS ARSE———— ~-Geometr yw.w.ﬂ....w...".mm S S SRR S S Sl S I
|

| Bounding Box (pm); X 1010.0,1190.0 Bounding Box (pum). X: 1010.0,1190.0
3 Y: 4100,170.0 ¥Y: 00,1700
| I -40,00 { 0217
Volume (pm=): 114142947768 | Volume (pm®): 48600.0
Centroid (pm): (1099.661454, 80.0, -2.176852) | Centroid (pm): (11000, 80.0,095)

[oc] o | (o] _cme | 0]

gﬂ‘ﬁ f1-12 Properties Y94 Substrate

] ¥ v
6. nannloAdY Face Selection Mode P& ioifoniiuiy

[
=

L ¥
7. AANYNNAULUUDIFU Diaphragm 1800 Set Name #3%013]u Top

8. ﬂﬁﬂm1ﬁ€f1uuummﬂ°;"u Diaphragm 1A Hide Selection Lﬁﬂ“gﬂu‘lﬁuﬁﬁ}ﬂ Top

9. ARRYNAG LAY T Diaphragm 1780 Set Name F1¥oiu Bottom

10. ﬂﬁﬂﬁulﬂﬂﬂu Layer Selection Mode & Lﬁﬂkﬁﬂﬂ‘é‘u Layer

11, nanuNRTY Diaphragm (36N Hide Selection o414 Diaphragm

12 ﬂﬁﬂﬁulﬂﬂﬂu Face Selection Mode ,ﬂj ﬂaﬂ‘llTl‘Yd;‘UE)lHjm Substrate ﬁy'aé"mﬁ'lu Anchor

13. ﬂﬁﬂ‘ﬁ Conductor 0 AANYIUADN Set Name éfa"i"aﬁ‘lu Diaphragm

14. ﬂﬁﬂ‘ﬁ Conductor 1 AANYIUADN Set Name Gi‘l‘?m‘ﬂu Substrate

Hnt1919 Parts Properties v2%1'10R8U Material Editors ionazaunsnnldountlas
auaaiad e veaTagilFusonldounlastagd 18 nnmihaeil srfinlasunases liildgn
wouaslulWa mpd m‘iﬂzt%um'lﬂiugma’.‘fau“mlmTﬂsn%‘ﬂﬁmﬁmua;‘hﬁnfu Faag liiifuados

fuTisi9ndu
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MIT319M1U18 (Meshing)

Vv

o ' ' . =

Junoude lveaniseonuuufenszuaunsad19n 1913 e Meshing F91a59a319v04

a Y1 ¥ i3 ¥ A o ¥
Mesh Model M18¢ 11111191139 Geometry 92@11150@314A9UYD4 Finite Element 1aive1i111 1410
. 4 . .:
A321IUN5 Solve YDA Finite element analysis Aa 131301000 311AY89015 Mesh ldnaruitdoya
" A a 3 o o &
AeqfaInmsadie Mesh  Tuszgainu 3 lugiudeyavesTusidmie14lun1s Solver
¥ b

Simulation 1UA7081392 @319 Mesh Y94 Diaphragm 1A% Substrate JVUADUAIT]

1. Anthane Geometry GOIGEN Regionl

2. AANYIMEUTDN Mesher Setting 921510111813 Mesher Setting @331/ n-13

=

3. NHTA19 Mesher Srtting 180N Mesh Type i Tetrahedrons
1390 Element odder 11]1 Parabolic

1A Element size L‘:L‘]‘u 10.0

o v oA

Adnfilfu OK tieTlanii1d1a Mesher Setting

7. AANT10ADY Generate Mesh 1#D1513 Mesh 50dnA3

8. vzdminguihiedsgii n-14

9. MIAMUVUNIIA1L Preprocessor ARNIADA Mesh > Mesh Quality

10. 921/31nM¥1613 Mesh Quality Report 110193 1002186AY89015 Mesh
11. Aaniifu OK ifeTlani19e Mesh Quality Report

12. AAAFDN File > Save tofufindeoya Mesh

13. Aaniaen File > Exit IN009NIN Preprocessor

i e R Wﬁa;igﬁ:smr?-';;rs
‘Mesher Setti Nt

Mesh Type ITetrahedmns

Element order (™ | jnear A ' Parabolic ‘&

Elemert size  [10.0]

[¥ Generate mesh Advanced l

Lo ] _cme | T}

" ¥
517 n-13 N15A3A1 Mesher Setting



| { a J o <
31N 014 TumaNiAAYLUNEI919M5 Mesh 1a3audn

(Viash Quality Raport e

6.86928541 (0.35%) :
7.70420649 (0.04%) :
.53912758 (0.00%) :

------------ Histogrem: Surface Mesh Element Edge Length --——-——=-=-=---
Edge length range [0.75,8.53913] / Number of values: 35448

1.52891275 (2.68%) :%%

2.30782551 (l.49%) :*

3.08673827 (6.16%) :#rvvan

3.86565103 (16.2%) ;*rrrssrszaranss

4_64456379 (54_2*) N R R R N R R TR RN R AN R R R E R R AR AR AR A RN EANNTNRR
5.42347655 (13.9%) :vraasersvass

6.20238930 (4.42%) :rxxx

16.98130206 (0.59%) :

7.76021482 (0.12%) :

8.53912758 (0.00%) :

311 0-15 Mesh Quality Report
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y A A
M31%In30338 MemElectro
iWhuasesilddmiuudilymina Electrostatic Tao1435msAaam11lseq (charge) uas
_ EE 4 . 4
A1 (Capacitance) NI¥OUDYTEH I Diaphragm 110¥ Substrate mﬁ‘lumuﬂs:ﬂﬂmaﬂmﬂaw
15 o y o { L)
#3191 MemElectro 1435113 Boundary Element Method (BEM) ifie 15 lunisfiuaamnlszyiiog
¥
a " [l o " p a o
vuiuAudazauuazuaadliiiuga Final solution Aumsfiuanninisnszaovesiszyues
:Y b
a9 luluea Tunoudaail
A A A a P a A "y ' '
1. 1ABNUOLIATBINBMIAATIZH IAUMIAANNLOY Analyzer DYAIUAIIUDIFDI
Process LUHTIIA1 Function Manager
o = d a a ]
2. MUUANMSAATIZHIFING lavaantaon MEMS 9104949 Domain
AANIADN MemElectro NI Solver(effects)

AANIADA Diaphragm 91N Model/Mesh

B

5. Tuxroq Analysis AANIABN Create a new analysis

6. AANT loAdY Solver Setup x5 1N MIIA1A317 n-17

 CoventorWare - D:\Design_Files\DiaphragmDesignDiaphragmbesign.mps [

File Tools Help

Materials | ; d ks JE’:‘JEJ
Process | ; rhisirrdezigmlioy Rt :«]ﬁl:z:,i'i

Archilect| Designer Anayzer |

Domain 43 ~ mems B © Microtuidics

Solver (effects) Ir”‘] MemElectro  (electrostatic and eleclroquasistatic)

ModelMesh

Analysis [craale a new analysis

iAutoBullder finished! W

U n-16 MsifionAIveINISAIMINLDY MemElectro
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N196AT MemElectro Setting Windows

ﬁﬁﬁwi”lﬂ Setting Windows Lﬂﬂﬂﬁ?fﬂﬁ“ﬁﬂi%iﬂﬂﬁ U Electrostatic Solver H‘LTMN‘.{i]Sﬁ
Asudu 13 udmdenmsainTensu Solver Setup Asadanaraasond ldou-ulald
awanmnzauvesilymifisiaule SnadeannsaderiluTnua Advance 181umeaans
Advanced Setting ﬁm%’uﬂiymﬁcﬁ'm’fﬂu Tﬂuﬁﬁﬁmsﬁaﬁ’

¥
1. Tum @19 MemElectro Setting 1iumdsduveoalalsunsy
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Source of sound

Sound pressure

Sound pressure level

pascal dB SPL
Theoretical limit for undistorted sound at 1 101,325 Pa 194 dB
atmosphere environmental pressure
Krakatoa explosion at 100 miles (160 km) in air 20,000 Pa 180 dB
Simple open-ended thermoacoustic device 12,000 Pa 176 dB
M1 Garand being fired at 1 m 5,000 Pa 168 dB
Jet engine at 30 m 630 Pa 150 dB
Rifle being fired at 1 m 200 Pa 140 dB
Threshold of pain 100 Pa 130 dB
Hearing damage (due to short-term exposure) 20 Pa approx. 120 dB
Jet at 100 m 6—200 Pa 110-140 dB
Jack hammer at 1 m 2 Pa approx. 100 dB
Hearing damage (due to long-term exposure) 6x10 ' Pa approx. 85 dB
Major road at 10 m 2x10 '~ 6x10 'Pa 80 - 90 dB
Passenger car at 10 m 2x10 *—2x10 'Pa 60 — 80 dB

TV (set at home level) at I m 2x10 ' Pa approx. 60 dB
Normal talking at I m 2x10 °—2x10 *Pa 40 - 60 dB
Very calm room 2x10 *~6x10 'Pa 20 - 30 dB
Leaves rustling, calm breathing 6x10 " Pa 10dB
Auditory threshold at 2 kHz 2x10 ° Pa 0dB
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Density p kg /m? kg / pm? kg / pm?
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Heat Flux q W/ m? kg /s pW / pm? kg/s
Length 1 m pm pm
Mass m kg kg kg
Moment of Inertia 1 kg - m? kg - um? kg - pm?
Piezoresistive CoefTicients 1,702, Ty MPa!
Poisson’s Ratio v
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ABSTRACT

To study and design the piezoresistive microphone, CoventorWare™ software package
was used to simulate the responsc of diaphragm from the thickness of 0.1 um to 0.5 pm, with
surface dimension of 500*500, 1000*1000, 1300%1300, 2000*2000, 2500%2500 and
3000*3000 um®. The sound pressure, used in the simulation, started from 20 pPa to 60 pPa (0
to 10 dB). The result wili be used to determine the optimal position of strain gauges. From the
simulated model, it can be seen that diaphragm experienced the highest stress at the egde,
hence this is the most appropriate place for the resistor. The most appropriate dimensions are
3000*3000 um” on cach side with a thickness of 0.1 um. With these dimensions, the
calculated stress is the highest from all the different conditions used in the simulation. There
will be two types of orientation used in placing the resistors: perpendicular and paralle! to

direction of the strain. The position for parallel placement is £, , = x,0 where x is in the range

of 1250 - 1750 pm. The position for perpendicular placement is £, = 1500,y where y is in
the range of 30 - 140 um.

1. INTRODUCTION

There are several detection mechanisms used for microphone, ¢.g. piezo microphone,
capacitive microphones, dynamic microphones, and carbon microphone [1]. A microphone
relies on the same principle as sensor, i.e. converting physical signals to electrical signals [2],
as shown in figure 1. A microphone can be used in many systems, for exampie, telephone
handset, tape recorder and computer.

Physical dimension Microphore Electncal signal

Figure 1. Block diagram of microphone system

" Corresponding author. Tel: 66{0)2 321 4276, Fax:66(0)27390643,
E-mail:dindangs@ hotmail.com
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Hearing aids is one such zpplication for microphones. It is a device ©© assist patients with
partial hearing loss. The ecarly commercial device focused on recovering the ability to
communicate with fellow human beings, such as telephone or face to face conversation,
Therefore, the sound pressure range is quite high, and achievable using normal microphone.
As time progress, users tend to require more sophistication from the hearing aids, for example,
achieving quality high enough for music appreciation or the ability to hear very low sound
pressure. For these reasons, it is beneficial to study the microphone working at low sound
pressure. C oventorWare ™ software package [3] was used for simulation and study various
microphone structures under different pressure conditions. The result will be incorporated into
the design and fabrication phase of the project.

2. MATERIALS AND METHODS
2.1. Small deflection theory

In order to determine the optimal design of the sensing resistors including position,
orientation and length, conventional theories of solid mechanics have been investigated. Since
linear responsc is desired, these pressure sensors arc designed to be operated in the small
defection region. Two types of diaphragms are considered including both circular and square
shapes [4]. This paper used square shape.

2.2. Stress and piezoresistive coefTicient of resistor

The strain gauges for the piezoresistive pressure sensor are normally arranged as shown in
figure 2. There are two resistor arranged so that the current will flow perpendicular to the
strain field (R, and.R;). In contrast, the other two resistor will have current flowing in paraliel
to the strain field (R, and Ry). The change of resistance both in paraliel and perpendicular to
the strain field will be related to the siress and piezoresistive coefTicient [5-6] as shown in
equation 1.

2

R

Figure 2. Strain gauges positioning

AR
—E— = 1,6, + A0, (1

TAR
where, i_?]l is a ratio between the change in resistance and the original resistance

7, isthe longitudinal piezoresistive coefficient.
7, is the traversal piezoresistive coefficient,
o, is the longitudinal stress.

O, is the traversal siress.
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2.3. Sensitivity

One of the most important parameters of a sensor is sensitivity. A good sensor should
have high sensitivity and also high stability. Sensitivity with respect to pressure [5] can be
calculated from the following equation,

i'é_fi}
S=-L R |_mo, +70 -
P P

where, S is the sensitivity with respect to pressure,
P is the pressure.

2.4. Simulation.

Before a simulation can occur, there need 1o be a solid model of the device. This can be
achieved through the features of the software package. Firstly, a process flow need to be
established. This flow resembles very closely to the actuzl fabrication steps with some detail
removed to simplify the final 2D model. Since only the diaphragm is of interest, the actual
flow will only have a few steps as shown in figure 3. During this time, material, film coverage
characteristics, mask layer name, etch profile and film thickness are also specified. The
mazterials for substrate and diaphragm are single crystal silicon and polysilicon respectively.
The diaphragm thickness was specified starting from 0.1 pm to 0.5 pm.

Figure 3. Process flow and material selection for diaphragm fabrication

After specifying the process flow, the layout of the device need to be designed. This is the
physical dimension of both substrate and the diaphragm as shown in figure 4. The layout can
be drawn using the software own tools or importing from other tools using standard formats.
There are six sets of diaphragm dimension: 500*500 pm-, 1000*1000 pm~, 1500%1500 pm-,
200042000 pm’, 2500°2500 um’ and 3000°3000 pm’.

After designing the layout, the software need to build a solid model of the device using
the parameters specified previously. The 3D model will then be meshed with different element
sizes and shapes. There is 2 need to experiment with element size in order 10 lessen the
simulation time without losing the accuracy. The resulting meshed model is shown in figure 5.
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Figure 4. 2D layout showing substrate and diaphragm

L k

Figure 5. 3D solid modeling of substrate and diaphragm before and after meshing

To stant simulation, pressure load need to be applied to the diaphragm. For this work, the
pressure starting from 20 jPa 1o 60 uPa was used. This corresponds 1o the sound pressure at
the lowest limit that human ear can respond. The graphical representation of stress in figure 6
shows that the area with highest stress is at the edge of the diaphragm.

Figure 6. The resulting graphic showing stress distribution over the diaphragm
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3. RESULTS AND DISCUSSIONS

The simulation results, after varying pressure, diaphragm dimensions and thickness, are
shown on the figure 7(a)-7(f).
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Figure 7. Applied pressure versus maximum stress for different diaphragm dimensioes 1a)
500*500 um", (0)100021000 pum-, (c) 1500*1500 pm-, (d) 20002000 um’, (e) 2302300
pm’, (f) 3000°3000 pm-

From figure 7, after applying various pressure lo the diaphragm, it can be seen way: the
highest response occurred at 3000*3000 pm2 diaphragm (figure 7(f)). Furthermore, fue the
same dimension, the diaphragm with 0.1 pm thickness has the most change in term of stress.
This means that if the displacement of the diaphragm is large, then the related stress wail also
be large. Since the stress is also related to the change of resistance, these relationshis can be
used to design the microphone with appropriate sensitivity.

The first equation shows that high stress will cause large change 10 — and hence soud

sensitivity (equation 2). For this reason, the dimension of the dizphragm was chosen 1w e
3000 * 3000 x 0.1 um’. The simulated stress is in the range from 5 x 107 10 9.9 « 10 \{oy
We used this sct of dimension to find and appropriate location for the strzin gauges. Thene are
two types of resistor placement. One is the resistor in perpendicular (R,) to the adge. and the
other type is the resistor in parallel (Ry) to the edge (figure 2).

In order to examine the strain field in more detail, the 3000 x 3000 pm’ diaphrssm was
meshed as square grid with 10 x 10 pm” grid size. This will heip locating the area with the
maximum strain (and hence stress) as shown in figure 8.
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Figure 8. Show strain field in one direction
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The simulation showed that the area with maximum stress is located near the edge of the
diaphragm. In order to find the exact location for resistors placement, a plot of strain against
the position along the edge is used. Figure 9 shows that even with different applicd pressure,
the curves have similar shape. The area with maximum stress is in the middle area along the
cdge.
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Figure 9. Show strain relative to the position on diaphragm along the edge
From figure 9, the mest appropriate area for R, is £ _ = x,0 where x is between 1250 and
1750 ym. The highest stress point is at x = 1500 um. Using this as a stanting point, the
position for R, can be found using the plot from figure 10. This plot shows that the appropriate
range is £, = 1500, y where v is between 30 and 140 pm.
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Figure 10. Show strain relative 1o position on the diaphragm moving toward the center



4. CONCLUSIONS

From the model, we can confirm the relationship between stress and resisiance change,
and hence the sensitivity. Furthermore, the location of highest strain can determine the
position of perpendicular resistors and parallel resistors. The position for parallel placement is

€,,= %0 where x is in the range of 1250 - 1750 um_ The position for perpendicular

e 2

placement is £ _ = 1500,y where y is in the range of 30 - 140 pm.
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Abstract

This paper presents the result of sensitivity and Evsteresis of
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